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Copyright 

Copyright © 2019 OSSI, LLC All rights reserved. 

Information in this document is subject to change without notice.  
The software described in this document is furnished under a 

license agreement or nondisclosure agreement.  The software may 
be used or copied only in accordance with the terms of those 

agreements.  No part of this publication may be reproduced, 
stored in a retrieval system, or transmitted in any form or any 

means electronic or mechanical, including photocopying and 
recording for any purpose other than the purchaser’s use without 

the written permission of OSSI. 

OSSI, LLC 

10125 S 52nd St. 
Franklin, WI 53132-8677 
ossi-usa.com 

 

Telephone: (262) 522-1870 

Toll Free: (888) 488-2623 

Fax: (262) 522-1872 

Trademarks 

Intelli‒Site® is registered in U.S. Patent & Trademark Office.  

All other registered and unregistered trademarks are the sole 

property of their respective owners. 

  

http://ossi-usa.com/
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Technical Support Assistance 

OSSI, LLC Headquarters 

OSSI, LLC 
10125 S 52nd St. 

Franklin, WI 53132-8677 

(262) 522-1870 

(888) 488-2623 

Technical Support 

Technical support is available via telephone or email.  Contact 

Technical Support 8:00 AM to 5:00 PM Central Standard time.  If 
calling after hours, please leave a detailed voice mail message, 

and someone will return your call as soon as possible. 

Email: support@ossi-usa.com 

Phone: (888) 488-2623 

When calling, please be at the computer prepared to provide the 

following information: 

• Product version number, found by selecting the About 

button from the Intelli‒Site Application Menu. 
• The type of computer being used including, operating 

system, processor type, speed, amount of memory, type of 
display, etc. 

• Exact wording of any messages that appear on the screen. 
• What was occurring when the problem was detected? 

• What steps have been taken to reproduce the problem? 
• It is highly recommended that the user generate a support 

package for transmission to Intelli‒Site technical support 
staff. To generate the package, run the Intelli‒Site 

Configuration Utility. Create Support Package… is the last 

option in the Tools menu. 

 

  

mailto:support@ossi-usa.com
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1 Introduction 

ISConnect v4.0.x Suite is the Intelli‒Site software tool set used to 

import information from an external data source (database or file) 

into the Intelli‒Site software system. There are two parts to this 
suite. ISConnect.exe is used to create configurations that define 

data mappings from the source material to the Intelli‒Site 
database. It can also be used to perform the import. 

ISImporter.exe is command line program to import the data using 

a configuration file created with ISConnect.exe. 

ISConnect v4.0.x is expected to be used as part of an automated 

process to import information from a system that is outside the 
Intelli‒Site software suite. This information is integral to site 

security and usage; therefore, a customer may need to have the 

data imported on an ongoing basis. 

The integrity of the source data by its very nature is the 
responsibility of the provider of the source data. It is required that 

the data be generated and verified by their database system. 

It is expected that during the creation of the ISConnect v4.0.x 

configuration any discrepancy in the data definitions will be 

addressed. Minimal automatic data validation can be performed. 
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2 Installation Guide 

ISConnect is a component module in Intelli‒Site. It must be 

installed. No external software is needed. 

Note: ISConnect can be installed as a remote client. No other components 
are required. All necessary software will be installed when ISConnect 
is selected. 

If Intelli‒Site has been installed without the ISConnect 

component, run the Intelli‒Site installer again and select Modify. 

During the initial installation, a Complete install will include 
ISConnect. If only ISConnect is to be installed, select ISConnect. 

Otherwise, select Custom to check the various components 

needed. 

 

Figure 1 - Installation Setup Type window 

For modify installation process, you are presented with the Select 

Features window. 
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Figure 2 - Select the components you want to install 

Ensure the ISConnect option is checked then continue with the 

installation or modification. 
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3 Licensing 

Configurations can be created without the ISConnect module 

being licensed. But the license is required before an import can 

take place. Contact your sales representative to add the 

ISConnect module to the license. 

 

Figure 3 - License tab of the About dialog with ISConnect module 
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4 UAC Requirements 

ISConnect v4.0.x must write to the Intelli‒Site logs folder. This is 

a protected, system folder. Therefore, both ISConnect.exe and 

ISImporter.exe must “Run as Administrator”. Import will not 
begin otherwise. The installer will set the appropriate properties 

allow the programs to run at the elevated privilege no matter who 

executes them. 
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5 ISConnect Configuration 

Before data can be imported into Intelli‒Site, a data import 

configuration file must be created. This section explains: 

• Creating or opening a configuration 

• Designating the source data 
• Designating the destination Intelli‒Site Engine location and 

login credentials 

• Mapping the source data to the Intelli‒Site data 

5.1 Creating or Opening a Configuration 

Before data can be imported, there is information the tool needs. 
The data source and the destination Intelli‒Site Engine location 

must be defined. Once defined, the data mapping can be defined. 

This information is stored in an XML configuration file. 

5.1.1 Create a New Configuration File 

Run ISConnect. In the File menu, select New…. The Data Import 
Project window displays. The name of the configuration is in the 

title bar. The default name for a new configuration is 

“ImportProject”. 

 

Figure 4 - New Data Import Project Window 

Notice under both the and buttons is “<Not 
set>”. This indicates that the data source and destination have 

not been defined. 
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5.1.2 Open an Existing Configuration 

Run ISConnect. In the File menu, select Open…. Using the 
standard Open dialog, navigate to and select an existing 

configuration file. The Data Import Project dialog displays. The 

name of the configuration is in the title bar. 

 

Figure 5 - Data Import Project dialog 

Loading the file may take some time as the source data or 

destination Engine may reside locally or on a different computer. 
If the source is a database, the network is polled to find all 

available SQL servers. The Engine is logged into and the possible 
database fields are loaded. A status window may pop up to explain 

the delay. 

Notice that in the above example, the data source is a flat file and 

the destination is localhost, meaning Intelli‒Site is running on the 

same computer as ISConnect. 

5.1.3 Save a configuration file 

To save a configuration file, use the File menu on the main 

window. Select Save or Save As…. 
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5.2 Designating the Source 

The source data is the repository from which the data to import 

comes. To designate the source, click the button on the 

Data Import Project dialog. The Data Source Setup dialog will 

appear. 

 

Figure 6 - Data Source Setup dialog 

The data source can be either a database or a file. Click the 

appropriate radio button, Database or File, according to the 

source type. 

5.2.1 Database Source Type 

If the data source is a database, click the radio button next to 
Database.  The fields associated with defining a database become 

enabled. And the fields associated with File are disabled and 

greyed-out. 
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First designate the source Database Server. Either type in the 
<server name>\<instance> (e.g., LATWin10SQL\SQLEXPRESS or 

.\SQLEXPRESS) or locate and select the appropriate database 

server in the Database Server drop down list.  

Note: If it has not done so already, ISConnect may need to load the 
available SQL Servers. This process takes time. Even if there is only 
one SQL Server, the discovery software will poll the network for any 
available servers. It doesn’t always find all or any of them. Microsoft 
even admits it. Therefore, it is best to type in the name of the SQL 
Server and instance <server name>\<instance>. 

Then in the Authentication group box, define the authentication 

credentials for the selected database server.   

The tool will then query the database server for a list of possible 

databases. Select the database from the list in the Database 

drop-down list. 

The list of tables in the selected database will populate the drop-

down list next to Table.  Select the desired table.   

If any of these steps are attempted outside the order given an 

error message window will appear.  Clicking on OK will bring the 

user back to the Data Source Setup window. 

Once the data source is defined, press the OK button.  The window 

disappears and the Source column of the data mapping table is 

filled in with the possible columns from the specified source 

database and tables. 
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Figure 7 - Data Import Project dialog with Database as source 

Notice the text below the button. It shows that the 
source is database by displaying both the server and database 

names. 

5.2.2 File Source Type 

For a file to be a valid data source, it must be either a tab-

delimited or comma-delimited text file. The first line of the file 

must define the columns of data. 

To select a file as the source, click the radio button next to File.  

The Database and Table fields will be disabled and grayed-out. 

Type in the name of the file or use the  button to browse.  

Then press the  button. 

ISConnect will read the first line of the file to fill in the Source 

column on the Data Import Project dialog. 
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Figure 8 - Data Import Project dialog with File as source 

Notice the text below the button. It shows that the data 
source is a flat file and it displays the name of the file using the 

full path. As you can see, the source file is not on the local machine 

but on LORI-DESKTOP. 

In addition, the Source column has been filled in with the column 

headers from the file. 

5.3 Designating the Destination 

To specify the Intelli‒Site destination, press the button 

on the Data Import Project dialog.  The Data Destination 

Setup dialog appears. 
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Figure 9 – Data Destination Setup dialog 

ISConnect does not have to run on the same computer as the 

Intelli‒Site Engine. ISConnect and ISImporter are clients of the 
Engine just like the Desktop Client or the web client. In the 

Engine Address type the IP address or host name of the 
computer on which the Engine is running. The default value is 

localhost. The Engine Port field is set to the default Engine port. 
If the Engine port is different, set the Engine Port field to the 

correct port number. The Engine Address and Engine Port can 
be found in the Setup Services dialog in the Intelli‒Site 

Configuration Utility. 
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Figure 10 – Engine Connection Settings group box in the Configuration Utility: 

Service Setup dialog 

Provide a valid username and password. It is strongly suggested 

that a user be added to Intelli‒Site specifically for ISConnect.  

If the imported cards are to be downloaded as they are imported, 

check Automatically download cards.  

Click the button on the Data Destination Setup 

dialog. ISConnect will use this information to login to Intelli‒Site 
to load the names of the database fields then logout. A status 

window will display while this information is being gathered.  

Note: Because ISConnect is a client, it affects and is affected by the 
Concurrent Connections limit of the license. Ensure the license 
accommodates at least two concurrent connections. 
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Figure 11 - Data Import Project dialog with the Destination set 

Notice the text below the button. It shows that the data 
destination Engine Address is localhost, the Engine Port is 9600 

and the username is ‘master’.  

Clicking on a drop-down list in each row of the Destination 
column reveals the list of database fields available for mapping. 

There are two database tables used for the destination fields. They 

are Card and Personnel. 
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Figure 12 - Destination database drop-down list 
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5.4 Mapping Source Data Fields to Destination Data 
Fields 

There are three columns in the data mapping table on the Data 

Import Project dialog.  They are Unique ID, Source, and 

Destination. 

 

Figure 13 - Data Import Project dialog with mappings 

Unique ID – checkbox; when checked this mapping row will be 
used to search the Intelli‒Site data for an existing record.  There 

are two database tables to which mappings can be made. They 
are Card and Personnel. If a card is being added, or modified or 

assigned an access set, the Unique IDs designated by the user 
must include Card.card_number. If a person is being added or 

modified, at least one Unique ID must be mapped to the 
Personnel table. This field or field combination should be the 

means by which an individual is uniquely defined in your system. 

It could be Personnel.name_last and Personnel.name_first. Or it 
could be a field added by your administrator to for employee 

number (e.g., Personnel.employee_id) 

Note: It is strongly suggested that all configurations contain a Unique ID 
for each table. 

Source – fixed; the Source data fields. If the source data is a file, 
this column contains the field names supplied in the first row of 

the designated file. If the source is a database table, the column 

contains the fields from the table 
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Destination – drop-down lists; the list of fields in the destination 
database tables. For each row of the table, if there is a destination 

element selected, then the mapping exists and is defined.  If a 
destination element is not selected, then the row is not part of the 

mapping specification even if the Unique ID is checked. 

5.5 Mapping Access Sets 

At the bottom of the list of possible destinations is the generic 
access set.  This is a place holder for the possible access sets that 

the customer can map to.  As an access set is added to the 
mappings, a new generic access set is added to the list.  The real 

names for the access sets are in the data itself.  The fields mapped 
to these Access Sets must be the name of an “Access Set” defined 

in Intelli‒Site.  They must match perfectly. 

Note: Access Sets from the source data are matched to the Intelli‒Site 
access sets by name.  Therefore, the names for the Access Sets 
must be unique across the whole project.  If there is a duplicate 
name, the import will abort.  

 

 

Figure 14 - Access Set in the Destination data drop-down list 
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Once the mappings are defined, you may save the configuration 
using the Save As… option of the File menu in the main window. 

You may also import the data immediately using the 

button. You may also run ISImporter using this configuration. 
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6 Import 

Import can be done via both the ISConnect user interface and the 

ISImporter invoked from the command line or as a Windows Task. 

Once a configuration is created and tested, the standard usage 
will be ISImporter as a Windows Task that runs at regular intervals 

such as nightly, hourly, once a minute, etc. depending on the 

needs of your installation. 

If the source data is a flat file, it will be renamed when the import 

is done, successful or not, to prevent importing the same data 
repeatedly. The date and time is appended to the file’s name (e.g., 

Rutgers Import Load 09-29-2019 01_02_33.txt). 

6.1 Using ISConnect 

Once a configuration is opened or defined, press the 

button.  The import will proceed.  A status window will pop up to 

inform you when the import is done and if it succeeded or not. 

A log file, ISImporter.log, is appended to for each import 

performed whether the import is done via the ISConnect or the 

ISImporter tool.  If it does not exist, it will be created. 

If any error occurs during the import process, a detailed message 
is written to ISImport.err. Not all errors are fatal. ISImporter will 

quit processing the current record and move on to the next if the 
error is specific to the current record. If the error is related to the 

whole import process, then it will be abandoned. The ISImport.err 
file is for debugging purposes and may be asked for by the Intelli‒

Site support team if there is an issue. 

6.2 Using ISImporter 

The ISImporter command is found in the Intelli‒Site install folder. 

It is a command line executable and must be run from there. It 
has one parameter, the configuration file. This is a required 

parameter. The syntax is: 

ISImporter [Data Import Configuration XML File] 

where [Data Import Configuration XML File] is the fully 

qualified name for the desired configuration file. 
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A log file, ISImporter.log, is appended to for each import 
performed whether the import is done via the ISConnect or the 

ISImporter tool.  If it does not exist, it is created. This file contains 

progress messages and any error messages. 

If any error occurs during the import process, a detailed message 
is written to ISImport.err. Not all errors are fatal. ISImporter will 

quit processing the current record and move on to the next if the 
error is specific to the current record. If the error is related to the 

whole import process, then it will be abandoned. The ISImport.err 
file is for debugging purposes and may be asked for by the Intelli‒

Site support team if there is an issue. 

6.3 Data Validation 

The only field in the Intelli‒Site database that has a specific format 

that we can be 100% assured will not be violated is the 
Card.card_number, Card.site_code, and Card.card_format.  If 

these fields contain anything but numbers, the record will be 

skipped. 

Because we do not have control of the source data or how the 
data in either database is defined, we can have very little control 

when it comes to data validation.  The source database may store 
information in one format but it may map to a field of a different 

format.  It is up to the user to ensure the data is properly formed.  

When the source data doesn’t match the destination database field 

type, an error will be logged and the record will be skipped. 

The only other destination field types that we can attempt to 

validate are image types. 

6.4 Importing Images 

The image type supported by Intelli‒Site are the Windows image 

files (*.png, *.jpg, *.gif , *.tif, *.tiff, *.bmp, and *.wmpf). When 
ISConnect or ISImporter detects that the destination field is an 

image, it assumes the source data is an image. How that 

assumption is handled is different depending on the source type. 
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6.4.1 Flat File Source Type 

When the destination database field is an image type, ISConnect 
and ISImporter assume the source data contains the fully qualified 

filename of an image file. It will open the file, read it in as a byte 

array, and send it as a byte array. If any part of this fails, a 
message will be written to the log and the whole source line will 

be abandoned. 

6.4.2 Database Source Type 

When the source data is read, a blob, system.byte[], may be 

detected. ISConnect and ISImport read in the byte array and 
sends it to the destination as such. If it doesn’t match the data 

type of the destination database field, an error will be logged and 

the record skipped. 
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7 Logs 

There are two log files associated with ISConnect. They are  

ISImporter.log and ISImporter.err. ISImporter.err contains only 

error message. ISImporter.log contains the progress messages 

for each import. These files are appended to if they exist. 

Each time an import is begun, a header is written to 

ISImporter.log. 

9/23/2019 5:11:10 PM  ******************************************************************************************************** 

9/23/2019 5:11:10 PM  ************ 

9/23/2019 5:11:10 PM  ************  Import initiated for configuration: C:\Users\admin\Documents\ISConnect\Configs\Nightly.xml 

9/23/2019 5:11:10 PM  ************ 

9/23/2019 5:11:10 PM  ******************************************************************************************************** 

When the import ends, a footer is written too. 

9/23/2019 5:11:10 PM  ******************************************************************************************************** 

9/23/2019 5:11:10 PM  ************ 

9/23/2019 5:11:10 PM  ************  Import COMPLETED for configuration: C:\Users\admin\Documents\ISConnect\Configs\Nightly.xml 

9/23/2019 5:11:10 PM  ************ 

9/23/2019 5:11:10 PM  ******************************************************************************************************** 

These log files are written to the Intelli‒Site logs folder. 
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